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Introduction to the LCD 
Displays 

he CS4100[1|2]0 Intelligent Serial LCD displays with backlight are very 
functional and low-cost LCD that can be easily controlled by a C Stamp. The 
LCD displays provides basic text wrapping so that your text looks right on the 
display. The LCD display is compatible with the C Stamp microcomputer’s 

supplies and signal levels. In addition, these Intelligent Serial LCD also provides you 
with full control over all of its advanced LCD features, allowing you to move the 
cursor anywhere on the display with a single instruction and turn the display on and off 
in any configuration. The CS4100[1|2]0 LCD displays requires only a 5 V power 
supply and the connection related to transferring data to the LCD via the UART 
protocol. Many useful text formatting functions are built into the operation of the 
LCD. With this display and the C Stamp, users can design a professional-looking text 
user interface on any microcontroller application, supply an easy-to-use debugging 
interface that does not require a PC, and provide real-time sensor data output on 
autonomous robotic applications. 

Registering Your C Stamp or C Stamp Related 
Product 
At A-WIT Technologies we respect your privacy; however, we do ask you to register 
your C Stamp or C Stamp related product, so you can receive free of charge product 
updates. The registration procedure is simple. Just send an e-mail to tech_support@a-
wit.com with the word “REGISTRATION x” in the subject line, where “x” is the 
product number that you purchased. If you purchased more than one product, send an 
e-mail for each different product. 

Introduction to the CS4100[1|2]0 LCD Displays 
Traditional Text Liquid Crystal Displays (LCDs) requires 7 - 11 pins from a 
Microcontroller or Microprocessor to display text on the LCD. These Serial LCD 
Displays allow any device to display to the LCDs with only 1 pin using the standard 
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Serial RS-232 protocol. This simplifies the effort and reduces the code required by your 
Microcontroller. Because only 1 pin is required, other pins can be used for other 
purposes. 

The LCD modules consumes only 6mA of current while active if the backlight is not 
switched on, thus is suitable for battery powered applications. Users are also able to 
Hard Reset the LCD display; this means the user need not physically switch off and 
back on the unit to reset it. 

Pictures of the front and back of the CS410010 and CS410020 LCD Displays are 
shown below. 

CS410010:   

 

CS410020:   

 

Features 
The system level features of the LCD displays are as follows: 

1. Text positioning directly references to line numbers, allowing portable code 
that works with different LCD displays. 

2. Auto Power Off for BackLight to save power / battery. 

3. Automatic Text Wrap at the end of each line to the next line. 

4. Correct handling of Carriage Return <CR> character, moves to next line. 

5. BackLight control commands. 
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6. Hard Reset function which powers down the LCD display and up again. 

7. Can work with RS232 or TTL voltage levels with any settings. The LCD 
expects RS232 inversion. In other words, a logic 0 is 5V and a logic 1 is a lower 
voltage. 

8. Correct handing of Backspace character. 

9. Commands to clear any Display Line without clearing the whole screen. 

10. Automatic contrast setting, which can be set to Light, Normal or Dark by a 
serial commands. 

11. Able to display byte value as a decimal number on the LCD. 

12. Able to display byte value as a number with a zero in front if number is less 
than 10. Very useful for Date, Time and Cents displays. 

13. Able to display byte value as a Hexadecimal number on the screen. Very 
important for debugging. 

14. All commands can be tested from a PC terminal for easy verification. 

Connectivity and More Information 
The following figures describe the pin-out connectivity for both LCDs. 
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When using the LCDs, the following should be kept in mind: 

Allow a 0.8 second delay after power is applied before sending text or commands to 
the LCD module. 

The power supply should be +5 volts regulated capable of supplying at least 60mA if 
you want to use the LCD backlight. 

The Select Pin can be used to reduce the baud rate to 2400bps by pulling it to ground. 
Leaving the Select Pin unconnected keeps the baud rate at 9600bps. 

The serial data is sent to the LCD module via the Data pin. 

The Extender Port is optional. It allows moving the LCD module up to 20 feet away 
from a PC or Microcontroller using a standard 4 wire flat phone cable with RJ11 
connector. 

The Programming port is used for future upgrades of the LCD firmware and should 
not be connected. 

Serial Interface Settings: 

The LCD modules can accept both standard RS232C signals (+12V to -12V) or TTL 
Level signals (+5V to 0V). It can also work directly with 3.3v Microcontrollers. The 
LCD expects RS232 inversion. In other words, a logic 0 is 3.3V and higher, and a logic 
1 is a lower voltage. 

Before sending text to the LCD to be displayed, make sure the baud rate and other 
serial settings are correct. 

The default baud rate is 9600bps. To change the baud rate to 2400bps, connect the 
Select pin to ground. Upon power up, the new baud rate will be shown on the screen. 

The other serial settings should be: 1 Start Bit, 1 Stop Bit, 8 Data bits, No parity bit, 
and No Flow Control. 

Don't worry if you are not sure about all these settings above, because they are actually 
standard default settings for serial ports. 

To use these LCDs with the C Stamp, the Data pin must be connected to Pin 24 of 
the C Stamp. Make sure that you have the Data pin connected to pin 24 and pin 25 
grounded in the C Stamp. Make sure that you remove these connections before 
connecting the PC/programming cable for the C Stamp, and vice versa. 
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These LCDs can also be used with any regular I/O pin connected to the LCD Data 
pin, and using the C Stamp SEROUT2 function, but you need to put an inverter like 
the CS459020 between the C Stamp pin and the LCD. 
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Getting Started 
his chapter is a quick start guide to using the CS4100[1|2]0 LCD with the C 
Stamp. This assumes you have a C Stamp and an appropriate connection kit 
or development board with the RESET and START circuitry and the LCD 
properly connected to the C Stamp. You will also need a programming cable, 

power supply, PC running Windows® 2000/XP/Media/Vista, with a quantity of 
RAM recommended for the OS, sufficient free hard disk drive space for the software 
installations, CD-ROM drive, Internet access (recommended only), and available port 
compatible with your programming cable. 

Notices 
CSTAMP™ and CSTAMP™ Related Hardware Products, Software 
Products and Documentation are developed and distributed by A-WIT 
Technologies, Inc. All rights reserved by A-WIT Technologies, Inc. A-WIT 
SOFTWARE OR FIRMWARE AND LITERATURE IS PROVIDED 
“AS IS,” WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL A-WIT BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY ARISING OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR FIRMWARE OR THE USE OF 
OTHER DEALINGS IN THE SOFTWARE OR FIRMWARE. 

MPLAB C-18 and MPLAB C-18 Users Guide is reproduced and 
distributed by A-WIT Technologies, Inc. under license from Microchip 
Technology Inc. All rights reserved by Microchip Technology Inc. 
MICROCHIP SOFTWARE OR FIRMWARE AND LITERATURE IS 
PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL MICROCHIP BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY ARISING OUT OF OR IN 
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CONNECTION WITH THE SOFTWARE OR FIRMWARE OR THE 
USE OF OTHER DEALINGS IN THE SOFTWARE OR 
FIRMWARE. 

Getting Support 
If possible, please check the C Stamp website www.c-stamp.com under SUPPORT for 
any updates to documentation, changes, or notices that may have become available 
since your Installation CD was produced. If you continue to have any issues for which 
a solution is not found in the aforementioned website, please e-mail tech_support@a-
wit.com for help. 

Installing the Microchip MPLAB and C Compiler 
Software 
The first step is to install the Microchip MPLAB software that you will use to develop 
your programs. 

Insert your A-WIT provided Installation CD in your CD drive. Go to the MPLAB 
directory in the CD and double click on the “MPLAB vX.XX Install” file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

After the MPLAB installation is complete, switch to the C18 directory in the CD, and 
double click on the file in that directory. Follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. The only 
exceptions to accepting all the default options is that on the 5th and 6th windows of the 
installation process for the C18 Compiler, you have to select everything as shown in 
the figures below. This will ensure that MPLAB is configured to use the C18 Compiler. 
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Installing the A-WIT C Stamp Quick Programmer 
To install the A-WIT C Stamp Quick Programmer, switch to the CSTAMPQP 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Installing the USB Software 
If you purchased a product with a USB download cable, make sure that the A-WIT 
provided CD is in the CD drive of your PC and insert the USB cable in the USB port 
of your PC. Windows auto detects the new USB device. If Windows prompts you to 
install drivers for the USB cable device, follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. 

After the USB adapter has been installed, open a Windows Explorer window from the 
Accessories sub-menu in the Start menu, and right click on My Computer. Proceed to 
select Properties, and then select the Hardware tab. Click on the Device Manger 
button, and expand the Ports (COM & LPT) branch. Make a note of the COM port 
that has been assigned to the USB-to-Serial adapter. This is the port that should be 
selected in the C Stamp programmer software. 

Setting Up the C Stamp Software Templates 
To set up the C Stamp Software Templates, switch to the CSTAMP_Template 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Documentation 
Copy the DOCS directory from the C Stamp Installation CD to your C:\A-WIT 
directory. This directory contains all the C Stamp related documentation in PDF 
format. 
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Creating your LCD C Stamp Program 
Create a directory where you want to have all the files for your program; for example 
LCD_APP. We recommend making this directory under your C:\A-WIT directory, so 
you can have all your CSTAMP related files in one place. 

Copy the all files in your C Stamp Software Templates directory C:\A-
WIT\CSTAMP_Template to the directory you just made. 

Open the Microchip MPLAB IDE application. As shown the following figure, the 
IDE has several sub-windows. Depending on the resolution of your screen, your sub-
windows may have a different layout. However; you can move and resize these into the 
position that you want to fit your screen, and your layout for that particular project will 
get saved upon answering yes to the prompt of saving the workspace when you exit 
the software development environment. 

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

 

 

Go to the “File” menu to “Open Workspace…”. Then navigate to your program 
directory, and open CSTAMP_Template.mcw. 

Right click on CSTAMP_Template.mcp in the “Project” sub-window, and “Save 
as…” the name of your program project after you have navigated to your program 



A - W I T  T E C H N O L O G I E S  I N C .  

 11 

directory. For example, your program project could be named “LCD_APP”. Now 
when you open the Microchip MPLAB IDE (Integrated Development Environment), 
and go to your program directory to open the workspace for your program, you will 
see a .mws file with the name of your program preceding it. This is the file that you 
should open any time you want to work on your program. 

Double click on the main.c source and type the following code fragment where it is 
indicated. You can omit the comments for brevity, as they are written here to offer 
clarifications of what the code does. Do pay attention; however, to the indentation of 
the code blocks between curly brackets for loops, if statements, etc. Although 
indenting the code is not a requirement for the compiler to parse your code (i.e. any 
blank spaces are ignored by the compiler), it does help tremendously to make your 
code much more readable, and consequently, it makes finding any errors easier. 
Keywords and function names in the code fragment below are bolded. 

After you START the C Stamp in user mode as explained in the “Downloading and 
Running Your Program” section (this will not be the RESET/BOOT/DOWNLOAD 
mode), the program will run. This program assumes that your LCD is connected. The 
program will display “Hello” in the LCD. 

To send a string of text to the LCD module, just send the string via a serial pin. There 
is no need for any other commands. See example below. 

C-Stamp Example: 

// Allocate message 
  BYTE Buff[] = "Hello"; 
 
  PAUSE(800); 
// Display string at 9600 baud, 8 bits, no parity, 
// no flow control, no pace 
  SEROUT(0, 0, 9.6, 0, 8, 0, 0, Buff, 5); 

Save your program from the “File” menu or by clicking on the appropriate icon in the 
tool bar. Then “Build All” from the “Project” menu or from the tool bar. 

If the code was typed correctly, you will have a file in your program directory with the 
name of your program project and a .HEX extension. An example is 
LCD_APP.HEX. This is the file that you will download to the C Stamp, as explained 
up ahead. 

If you get an error message or an indication that your program did not build 
successfully in the “Output” sub-window of the IDE, you probably have one or more 
syntax error(s). Double click on the line of the “Output” sub-window that mentions 
the error, and the program line that most likely contains the error will be indicated in 
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the sub-window where you were editing your program. Correct as necessary, and 
“Build All” again until you get a successful .HEX file output. 

Downloading and Running Your Program 
Power up your KIT, and connect the KIT to the PC with the provided cable. Upon 
power up, the C Stamp will be in RESET/BOOT/DOWNLOAD mode. To go back 
to this mode at any time, just push and let go of the RESET button. Then open the A-
WIT C Stamp Quick Programmer application shown in the next figure. 

 

 

The first step is to choose the serial port that you are using from the drop-down menu. 
Then click on “Refresh”, so that the program registers your selection. Your selection 
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should show in the status area of the program next to “PORT:”. Then click on “Open 
HEX File” and load/select the HEX file that you had previously created during the 
development of your program. The status are should indicate that the file has been 
loaded successfully. This is what will be downloaded to the C Stamp. Then click on 
“Connect”, and the PC will be connected to the C Stamp, and the status area should 
indicate so. To download the HEX file to the C Stamp, just click on “Write Device”, 
and you should see the progress bar after a few seconds, as the HEX file is 
downloaded. At this point, you can click on “Disconnect” to disconnect the PC from 
the C Stamp, disconnect the serial cable from both the PC and the C Stamp, and start 
your program manually at the C Stamp. To do this just push and let go of the RESET 
button while pushing the START button. Then you can let go of the START button. 
Alternatively, you can click on “Normal Mode” to start your program from the PC. 
This will also disconnect the program/PC from the C Stamp. Then you can disconnect 
the serial cable from the PC and the KIT. You can also instruct the CSTAMP™ Quick 
Programmer to wait several seconds before starting your program from the PC and 
disconnecting by adjusting the “SECONDS TO START” slide. This feature is useful 
in case you want to keep the PC connected with the serial cable, but need time to 
manually set up something in a circuit that you have built. If this is not the case it can 
just be left at the default of “0”, and your program will started from the PC right away. 
After you click “Normal Mode” and your program is started, the CSTAMP™ Quick 
Programmer will not be communicating with the C Stamp any longer, so if you want 
to reconnect, you must click on “Connect” again. 
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Additional Functions and 
Commands Reference 

his chapter describes the functions and commands that are specific to the 
LCDs to complement the function and projects developed with the C Stamp. 
All commands must be preceded by a ESC (decimal 27) character. For 
example, to clear the screen, you must send char 27 before sending char 1. 

LCD Commands 
CMD Description Character 

Sequence 
Remarks 

1 Clear screen ESC, ‘1’ After clear, wait 10ms for LCD to 
recover. 

I Set cursor at 
line number, 

column 1 

ESC, I, ‘2’ This example sets the cursor at 
Line2, Column 1 without clearing 
line 2. 

L Clear one line 
and sets 
cursor at 

column 1 of 
that line 

ESC, L, ‘2’ This example clears all text on 
Line2 and sets the cursor at Line2 
Column 1. 

C Show cursor ESC, C Shows the cursor. 

O Hide cursor ESC, O Hides the cursor. 

M Show 
number 

ESC, M, BYTE If the value of BYTE is 138, the 
screen will display “138”. 
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CMD Description Character 
Sequence 

Remarks 

N Show 
number with 
zero padding 
in front if less 

than 10 

ESC, N, BYTE If the value of BYTE is 9, the 
screen will display “09”. Useful for 
displaying minutes or cents. 

H Show BYTE 
value as a 

Hexadecimal 
number 

ESC, H, BYTE If the value BYTE is 171 decimal, 
then “AB” will be displayed. 
Useful for debugging. 

B Switch on 
backlight 

ESC, B, 0x0A In this example, the LCD backlight 
will be switched on for 10 seconds. 
The 3rd byte allows 2 to 255 
seconds ON time. Backlight 
cannot be switched on indefinitely.

S Switch off 
backlight 

ESC, S The LCD backlight will be 
switched off immediately. 

0 Hard Reset 
module 

ESC, 0 After this command, wait 0.9 
seconds for LCD to recover. 

P Set cursor 
position 

ESC, P, 0xC0 Set exact cursor location, for 
example line 1, col 1 = 0x80, line 1, 
col 3 = 0x83, line 2, col 1 = 0xC0, 
line 2, col 4 = 0xC4. 

D Set display 
contrast 

ESC, D, + 

ESC, D, - 

ESC, D, = 

Sets Display Contrast to Darkest. 

Set Display Contrast to Lightest. 

Set Display contrast to Normal. 
This is the default setting at power 
up. 

 

LCD Commands Examples 
These are examples of how to send commands to these LCDs. 

// Allocate message for clearing screen 
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BYTE cls[] = {27, '1'}; 
 
// Allocate message for backlite 
 
BYTE lite[] = {27, 'B', 0x0A}; 
 
PAUSE(800); 
 
// Clear screen 
 
SEROUT(0, 0, 9.6, 0, 8, 0, 0, cls, 2); 
 
PAUSE(800); 
 
// turn backlite on for 10 seconds 
 
SEROUT(0, 0, 9.6, 0, 8, 0, 0, lite, 3); 
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Terms & Conditions 
Quality Assurance 

A-WIT has stringent quality control procedures in place to insure the best quality 
products. 

90-Day Limited Warranty 

A-WIT Technologies, Inc warrants its products against defects in materials and 
workmanship for a period of 90 days. If you discover a defect, A-WIT Technologies, 
Inc. will, at its option, repair, replace, or refund the purchase price. After 90 days, 
products can still be sent in for repair or replacement, but there will be a $10.00USD 
minimum inspection/labor/repair fee (not including return shipping and handling 
charges). 

14-Day Money-Back Guarantee 

If, within 14 days of having received your product, you find that it does not suit your 
needs, you may return it for a refund. A-WIT will refund the purchase price of the 
product in the form of a check, excluding shipping/handling costs, once the product is 
received. This refund does not apply if the product has been altered or damaged. If you 
decide to return the products after the 14-day evaluation period, a 20% restocking fee 
will be charged against a credit. 

Disclaimer 

Warranty does not apply if the product has been altered, modified, or damaged. A-
WIT makes no other warranty of any kind, expressed or implied, including any 
warranty of merchantability, fitness of the product for any particular purpose even if 
that purpose is known to A-WIT, or any warranty relating to patents, trademarks, 
copyrights or other intellectual property. A-WIT shall not be liable for any injury, loss, 
damage, or loss of profits resulting from the handling or use of the product shipped.  

How to Return a Product 

When returning, you must first e-mail sales@a-wit.com for a Return Merchandise 
Authorization number. No packages will be accepted without the RMA number clearly 
marked on the outside of the package. After inspecting and testing, we will return your 
product, or its replacement using the same shipping method used to ship the product 
to A-WIT within 30 days. In your package, please include a daytime telephone number 
and a brief explanation of the problem. 

Please contact our Sales Department at sales@a-wit.com if you have any questions 
regarding our warranty policy or if you are requesting an RMA number. 
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